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Introduction 

 

Use of MVIEW (this software) display and play back image files (AVI / WMV / MCFF / still picture 

serial number file) and perform simple analysis using actual size conversion / automatic tracking. 

 

This user’s manual provides information on operations such as settings and applications to use 

the software equipped with these features. 

 

Make sure you understand the contents of this manual and the user’s manual for any peripheral 

devices, and are familiar with the operation before photographing anything important. 
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1. Overview 

1.1 Basic Functions 

The following can be performed with the MVIEW. 

■Playback of image file (AVI/WMV/MCFF/BMP/JPEG/TIFF) 

■Image measurement 

■Automatic tracking 

■Image overlay 

■Display of waveform data 

■Report output 

 

This software can zoom and scroll the image. 

This software can rotate and flip the image, and adjust the image quality. 

This software can perform synchronized display to display multiple file images simultaneously. 

This software can play video by specifying the play range, play direction and play speed.  
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1.2 Overview of Operations 

Launch MVIEW by double-clicking the shortcut icon on the desktop. 

 

 

MVIEW shortcut icon 

 

An overview of the flow of MVIEW operations is shown below. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

File image 

AVI/WMV/MCFF 

BMP/JPEG/TIFF 

Start 

Display file image 

Screen 1 / 2 / 4 split 

Waveform Data 

CSV/NWF 

Coordinate file 

CSV 

End 

Report 

BMP/JPEG/WOR

D 

Time series 
tracking data 

CSV 

Image quality 
adjustment setting 

INI 

Snapshot 
BMP/JPEG/TIFF/P

NG 

Test Information File 

INI 
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2. Operations 

2.1 Display file image 

2.1.1  Open / Close image file 

Specify 1/2/4 split with the button at the upper right of the screen, and specify the folder where 

the image file is located. 

 

Close the displayed image file with the [Close file] button on the upper right of the screen. 

 
 

2.1.2 Switch image 

Change the image to be displayed in the area with the up and down arrow buttons or the pull-

down at the bottom of the screen. The pull-down displays a list of image files in the folder 

specified when opening the image file. The list shows the file names excluding the extension. 

 

1 split 

 

2 split 

 

4 split 

 

 

 
 

The menu [File]> [Open additional exam] opens images in other folders. Since the images in 

other folders are opened with the image open, files in the folder opened later are added to the 

pull-down. 

Drag and drop the image file to open the image file. 

The dropped file is opened on the split screen where the image file is dropped. 

Select one of the listed image files. 

Designate a folder and open an image file. 

Switch the listed image file. 
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2.1.3 Video playback 

Perform playback operation with the toolbar at the bottom of the screen. 

 

 

 

 

 

 

 

Playback operation button 

Click the button to operate the image file. 

 

 
Jump to Start Frame Displays the playback start farame 

 
1 Frame Reverse Gose back one frame. Press for a long time to go back 

quickly. Reduce playback speed during playback. 

 
Stop Stop playback. 

 
Playback/Loop Playback / loop playback 

Hold down the "Play" button or click the "Play" button 

during playback to start loop playback. 

 
1 Frame Forward Goes one frame forward. Fast forwards if pressed for a 

long time. Increase playback speed during playback. 

 
Jump to End Frame Displays the playback end frame. 

 
Trigger Displays the trigger frame / event frame. 

 
Set as Start Frame Sets the current frame to the playback start frame. 

 
Set as End Frame Sets the current frame to the playback end frame. 

 
T=0 Setting Sets the current frame to the T=0 frame. 

Status bar 

Playback speed Frame specification Playback operation button 
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Status bar 

When the cursor is on the toolbar, the detailed information about the 

button display is displayed in the left corner. 
 

 When the cursor is on the image display section, the position of the 

cursor with the lower left of the image as the origin is displayed. 
 

 When the cursor is on the image display section, the RGB value of the 

image at that position is displayed. 

 

Playback Slider 

Use the playback slider to designate the playback frame or playback range. The current 

frame. 

 

 

 

 

 

 

 

 

The current frame, play range start frame and end frame are changed by dragging. 

Also, by moving the mouse wheel up and down with the playback slider in place, the current 

frame moves back and forth.  

 

 

Playback speed 

Use the frame by frame button to change the frame rateduring playback.   

-1920,-960,-480,-240,-120,-60,-30,-15,-7.5,-3.7,-1.8,-1, 

    1,1.8,3.7,7.5,15,30,60,120,240,480,960,1920 Unit:pps 

 
 

Dropped Frame Verification Indicator 

Verifies dropped frames by the color of the indicator. 

(green: no dropped frames; yellow: dropped frames; black: disabled) 
 

Top frame T=0 frame 

(trigger 

frame) 

End frame 
Playback 

end frame 

Playback 
start frame 

Playback range Current frame 
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・In “->->->” and “<-<-<-“ in the “Playback Rate” pull-down menu 

“->->->” is the fastest frame rate that does not drop frames and plays in the forward 

direction. 

“<-<-<-“ is the fastest frame rate that does not drop frames and plays in the reverse 

direction. 
 

・During separate playback in 2-split mode, if the same file is opened on the left and right, 

the same playback rate is applied to both images. 

 
 

Frame specification 

The current frame, the start frame and the end frame of the playback range can be specified 

by numerical input. 

 

Synchronization operation of playback / individual operation of playback 

Playback can be switched between synchronous operation and individual operation only when 

dividing into two. 

 

 

 

Sync Playback  Display the same time frame on 2 screens. 

 

 

Async Playback Two images can be played back independently. 

 

 
 

Display tool 

 

The display tool has three tools: [Zoom tool], [Hand tool], and [Show whole image]. 

・  Zoom Tool  Zoom in and out of the image with a mouse click. 

・  Hand Tool  Scroll the image by mouse drag. 

・  Display Entire Image Display the image so that the entire image fits in the screen. 
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T=0 Setting 

“T=0 Setting” means changing any frame to frame number 0. 

At the end of recording, the frame where the trigger signal is input is 0. 

 

The image file frame number verifies the photographed image and sets the T=0 setting 

so the frame number for the desired frame can be set to 0. 

In addition, the frame where the trigger signal is input can be set to the T=0 frame by 

performing [T = 0 reset] from the “Control” menu. 

 

Both T = 0 set / T = 0 reset apply to all displayed images. 

 

In addition, only in the case of split display and async playback, the [T = 0 set] button on the 

left image side applies the T = 0 setting to the left image, and the [T = 0 set] button on the 

right image side applies the T = 0 setting to the right image. 

When the same file is opened on the left and right, the [T = 0 setting] button on the right 

image side can not be pressed. In this case, the same frame is set as T = 0 frame in both left 

and right images by setting T = 0 with the [T = 0 setting] button on the left image side. 

 

2.1.4 Adjust Image Quality 

Adjust parameters related to image quality such as brightness characteristics, color balance and 

saturation for each image. 

Automatic tracking, report creation, and image overlay are analyzed and output based on the 

image quality adjusted here. 
 

note ・The image quality can be adjusted only for 24-bit image files. The image quality can 

not be adjusted for image files other than 24 bit, such as black and white images and 

32 bit color images including alpha channel. 

・Image quality adjustment is not possible for MCFF image files that are displayed in 

reverse (up and down, left and right) 

・Image quality adjustment is reset if the image is rotated after image quality 

adjustment。 
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The following image quality adjustment screen is displayed in [Image quality]. 

 

The result of image quality adjustment is reflected in the image display area and the histogram 

of the "Image quality" screen. 

It is easy to compare images before and after image quality adjustment by turning on / off the 

"Original Image" button.  

The histogram display can be switched on / off for each component of R, G, B, and Y by the 

"Output" check box.  
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□ Image switching for image quality adjustment 

When image quality adjustment is performed in 2 or 4 split screen, a red frame is displayed on 

the image for image quality adjustment. By clicking each divided image with the mouse, the 

image for image quality adjustment is switched. 

 

When the target is switched, the image quality adjustment is applied to the image selected 

immediately before the switch. Clicking [OK] on the image quality adjustment screen applies the 

image quality adjustment change to the currently selected target image and closes the image 

quality adjustment screen.  

Click [Cancel] to cancel the image quality adjustment change to the currently selected target 

image and close the image quality adjustment screen. The image quality adjustment applied by 

switching objects is still applied even if it is canceled. 

 

If the same file is opened in multiple split areas at the same time, the image quality adjustment 

is applied to all the split areas of the same file. 

 

□ Luminance Properties 

When the [Intensity] check box is turned on, the knob “■” for specifying the luminance 

characteristics is displayed on the histogram, and dragging with the mouse changes the 

luminance input / output conversion characteristics. 

When the "Rev." check box is turned on, the luminance is displayed inverted. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Specify the minimum intensity input value by dragging the left button. 

Adjust the gamma value by dragging the left button. 

Specify the maximum luminance input value 
by dragging the left button. 

"Reverse" check box 
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□ Image Quality 

Adjust color balance (RGB gain) and saturation, hue, brightness, contrast, and enhancement. 

For adjustment, enter a numerical value or drag the knob. 

Fine-tuning is easy by clicking the knob and using the keyboard left and right keys. 

 

① Switch between the original image and the image after image 

quality adjustment. 

② Restore image quality adjustment settings to original. 

③ Loads the image quality adjustment settings from the file and 

reflects them on the image. 

④ Save the image quality adjustment settings to a file. 

 

・Color Balance: Specify R, G and B gains as integers of 0 to 100 

respectively. 

・Chroma: Specify as an integer from 0 to 100. 

・Hue: Adjust the color tone with an integer from 0 to 100. 

・Brightness: Adjust the brightness with an integer from 0 to 100. 

・Contrast: Adjust the contrast with an integer from 0 to 100. 

・Enhance: Adjust with an integer from 0 to 3. 

The numbers 0 to 3 are eachIndicates 

0: OFF, 1: LOW, 2: NORMAL, 3: HIGH. 

 

Refer to "Appendix C Input / Output Data File Format (p. 59)" for the format of the image 

adjustment file. 

  

① ②  
③  ④  
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2.1.5 Rotate Image・Reverse Image 

For each image, rotate the image by 90 degrees, or flip it horizontally and vertically.Automatic 

tracking, report creation, and image overlay are analyzed and output based on the image 

rotation and inversion set here. 

 

Rotate Image：Rotates the image clockwise by 90 degrees relative to the original image. 

Reverse Image：Reverse the image horizontally and vertically with respect to the original image. 

 

   

 

When performing image rotation / reversing from the "View" menu, the specified image rotation 

/ reversing is performed for all currently displayed images. 

 

   

 

When image rotation / reversal is executed from the menu displayed by right-clicking an image, 

image rotation / reversal is performed for one image clicked on right. 

The check mark is displayed for the currently applied image rotation / reversal.  
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2.1.6 Maximaize Window 

When the image is opened in 2 or 4 split screen, enabling "Maximize Window" allows individual 

images to be displayed on the entire screen as in 1 split. 

 

 

 

If [Image View]> [Maximize Window] is enabled from the menu that is displayed by right-

clicking an image, one right-clicked image will be displayed on the entire screen in the same way 

as when dividing into one. 

 

When "Maximize Window" is activated, simple measurement can not be used in 2 and 4 split 

screen. Also, if image overlay is applied before window maximization, it will continue to apply 

after window maximization, so images can be superimposed and displayed on a large screen. 

 

Again, when "Window Maximize" is executed, "Window Maximize" becomes invalid and returns 

to the original number of divisions. 

Simple measurement can not be continued or the result can not be displayed on the screen with 

the original number of divisions, but since the measurement result is retained, measurement can 

be resumed by enabling "Window Maximization".  
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2.1.7 Display of waveform data 

If there are waveform files (CSV, NWF) in the folder, the graph will be displayed automatically. 

 

・Correspondence waveform file format 

CSV file 

Comma-delimited text file generated by Microsoft Excel etc. Refer to "Appendix C Input / 

Output Data File Format (p. 59)" for the format of the CSV file that can be displayed. 

 

NWF file 

Our application A waveform data file generated by HXLink's optional product "MEMRECAM 

waveform input software". 

 

・Graph / List display of waveform data 

The graph display and the list display of data are switched from the tab button at the top of 

the graph screen. 

 

CSV file  

graph List 

  

 

Two graphs of time and stroke are displayed. The horizontal axis of the left G-T graph is time. 

The horizontal axis of the right-side G-S graph is the stroke from the reference. The vertical 

axis is the input value of the channel. Stroke data is also output to the list. 
 

NWF ファイル  

graph List 

  

 

Only graphs of time are displayed. There is no graph of strokes, one graph is displayed. 

The horizontal axis is time, and the vertical axis is the input value of the channel. 
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・Waveform file selection 

If there are multiple waveform files in the folder, the following waveform file selection screen is 

displayed. 

 

Once a waveform file has been opened, it can not be switched with another waveform file unless 

the file is closed and the test folder is reopened. 

Click [Cancel] to display only the image file without opening the waveform file. 

 

・Graph Operation 

The graph operation is performed using the "waveform data control bar" in the red frame in the 

figure below.

 
 

Graph Button 

The following menu is displayed by clicking “Graph” on the “Waveform Data Control Bar”. 

Properties… 

Hide/Display Graph 

 

・Properties… 

Displays the settings for waveform data sampling. 

 

・Hide/Display Graph 

Switches the graph display ON / OFF. 

 

View Button 

The following menu is displayed by clicking “View” on the “Waveform Data Control Bar”. 

Display Settings… 

Cursor Style 

Legend  
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・Graph Display Settings 

 

 

Channel arrangement setting 

Join All Displays all used channels on one Y-axis. 

Separate All Display all used channels on separate Y-axis. 

Add Y Axis Add Y axis on the graph. The added Y axis is added to " Y Axis". Y-axis 

name can be changed in " Y Axis". 

Delete Y Axis Deletes the Y axis selected in "Y Axis". If a channel is registered on the Y 

axis, that channel will be moved to "Channels which not Display". 

=> The channel selected in " Channels which not Display" is registered to 

the Y-axis selected in "Y Axis", and the graph is displayed. 

<= Move the channel selected in "Y Axis" to " Channels which not Display" 

and delete it from the graph. 

 

G-S Graph reference position (Only CSV file can be set) 

Ground The channel data is displayed as it is in the GS graph, as it is referenced 

to the ground. 

Vehicle Specify the reference channel from the waveform data. Displays the 

stroke with the specified channel in the G-S graph. 

 

・Cursor Style 

Select the cursor shape that indicates the current position of the graph from vertical line / 

cross line / square. 

Reference position of G-S graph 

Channel arrangement setting 
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・Legend 

Turns ON / OFF the numerical value display for each channel displayed in the graph of 

NWF file and G-T Graph of CSV file.  

 

Tool Button 

The following menu is displayed when you click "Tool" in "Waveform Data Manipulation Bar". 

Move current frame 

Rectangular zoom 

Band zoom 

Zoom in on Playback Range 

Reset Zoom 

Set this Graph as Tick Master 

 

・Select the mouse operation on the graph. 

Move current frame 

Rectangular zoom 

Band zoom 
 

・Zoom of playback range 

Only the waveform data corresponding to the playback range of the image is zoomed and 

displayed.  

 

・Cancel zoom 

Unzoom the graph to display all recorded waveform data. 

 

・Use this graph as a reference for time ticks during playback 

Sets the playback speed reference to the waveform data sampling frequency.  

If the image recording speed is 1000 pps and the waveform sampling frequency is 

10,000 Hz and the playback speed is 30 fps, the waveform data will be advanced by 30 

pieces per second, and the image will be updated three times in one second. 
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Tool Buttons 

The functions of the "tool button" in the "waveform data control bar" are as follows. 

 

 

Move current frame.  

Drag the mouse on the graph to move the current position of the waveform data. 

 

Rectangular zoom.  

The specified range on the graph is enlarged and displayed. 

 

Band zoom. 

Displays waveform data in a specified range on the graph. 

 

 Zoom of playback range.  Only the waveform data corresponding to the playback range 

of the image is zoomed and displayed. 

 

Cancel zoom.  

Cancel zooming and display all recorded waveform data. 

 

 Makes the cursor shape a vertical line. 

 

 Makes the cursor shape a crosshair. 

 

 Make the cursor shape a square. 

 

 Sets the playback speed reference to the waveform data sampling frequency. 
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2.1.8 Snapshot 

Saves the currently displayed image display screen as a still image file (BMP, JPEG, TIFF, PNG). 

The contents displayed on the image display screen, such as image zoom, coordinate axes and 

measurement points of simple measurement, and image superposition, are output as they are 

to the image file. 

 

Graphs and images can be combined into a single image file and snapshots can be taken. 

By displaying the graph screen, an image file in which the currently displayed image and the 

graph are combined into one is saved. 

 

When a snapshot is taken, a file name indicating the snapshot acquisition date is automatically 

assigned to the save destination folder of the specified snapshot, and is saved in the specified 

image file format. 

Example) File name when snapshot is acquired in JPEG format at 20:05:40 on September 1, 

201820180901_20054.jpg 

* If snapshots are taken multiple times at the same time, branch numbers will be added at 

the end of the date and time. 

 

□ Method of snapshoto 

There are three ways to take snapshots: 

 

• [Snapshot] button pressed 
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• Menu [File] >[Snapshot] 

   

 

• Keyboard shortcut  Ctrl  +  S  

 

 

□ Open Snapshot Folder 

From the [File]> [Open Snapshot Save Destination] menu, the save destination folder for 

snapshot images is opened. 

 

 

□ Change the snapshot save destination and image file format 

 

From the menu [Settings]> [Options], the destination folder for snapshot images and the file 

format of snapshot images are changed. 

 

□ Snapshot images and graphs at the same time 

When a snapshot is taken with the graph screen displayed, the image and graph are saved as 

a snapshot image consisting of one image file. 

When the numerical value list is displayed or the graph is zoomed, the numerical value list or 

the zoomed graph is output as it is to the snapshot image. 

If the graph screen is hidden, the graph or number list is not output to the snapshot image. 

Also, if [Include graph screen currently displayed in image] in [Option] is unchecked, the 

graph or numerical list will not be output as a snapshot image even if the graph screen is 

displayed.  
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2.2 Measurement 

MVIEW has the following measurement functions. 

■Measurement Manually specify the measurement point on the image and measure the 

movement distance of the measurement point。 

■Auto tracking By specifying tracking points of up to 5 points and automatically tracking 

markers and feature points, it is possible to measure changes in movement 

trajectory and position, etc. 

 

2.2.1 Measurement 

Simple measurement can be performed in the 1-split display mode by splitting the image into 1 

or by maximizing the window. 
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The main steps of measurement are as follows. 

1) Set the coordinate system on the screen. 

2) Specify reference segment and actual length on the screen. 

3) Specify measurement points (fixed points or tracking points) on the image. 

4) Automatically track the tracking point. 

 

Below is a description of each step. 

1) Set the coordinate system on the screen. 

 

Select [Set coord syst.] And press the left mouse button on the screen to set the origin. 

Moving the mouse while holding down the left button tilts the coordinate system. 
 

The coordinate system origin is input numerically with the lower left of the image as the 

origin. The angle is input counterclockwise as a plus. 

 

The X axis is displayed in red and the Y axis is displayed in green.  

Checking [Visible] turns on / off the display of the coordinate system. 

 

2) Specify reference segment and actual length on the screen. 

 

Select [Set ref length] and press the start point of the reference line with the mouse on the 

screen. Drag and release the mouse at the end of the line. 

Next, enter the length (actual length) of the reference line. As the unit, select mm / cm / m or 

enter an arbitrary unit from the keyboard. 

The start / end point of the reference line can also be input numerically with the lower left of 

the image as the origin. 

 

Check [Visible] to turn on / off the display of the reference line. 
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3) Specify measurement points on the image 

 

Select [Add points] and click on the screen to add measurement points. 

When [Fixed] is selected from [Point type], the added measurement points become fixed 

points. 

If [Tracking] is selected and tracking points are added, [Tracking control] allows tracking of 

tracking points and deletion of tracking results. For details, refer to "2.2.2 Auto Tracking (p. 

27)".  

Checking [Visible] turns on / off the display of all measurement points. 

When [Show selected point] is selected, only the measurement points selected in the list will 

be displayed on the screen.  

When [Show only ‘+’ mark] is selected, the number (No.) of the measurement point is not 

displayed on the screen.  

When [Show tracks] is selected, the locus of the tracking result of the tracking point is 

displayed on the screen.  

In [Color], specify the display color of the locus of measurement point / tracking point. 

 

 

When the [Display] check in the list is switched ON / OFF, it is possible to switch between 

displaying / not displaying any measurement point on the screen. 

 

Select the measurement point by selecting the measurement point from the 

measurement point list or clicking the number part of the measurement point 

on the screen. However, if [Show only ‘+’ mark] is enabled, the measurement 

point number can not be displayed, so it is not possible to select the 

measurement point by clicking on the screen. 

 

The measurement results X and Y are the actual distances from the coordinate system origin. 

The angle is the angle [°] with the X axis of the coordinate system. The counterclockwise is 

positive. 

Point 
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Change the position and color of the measurement point selected in the list. 

When the position of the tracking point is changed, only the current frame is 

changed. The name and type of measurement point can not be changed. 
 

Deletes the measurement point selected in the list. 

Delete all measurement points. 
 

Import coordinate system, reference line, measurement result from exported CSV 

file. All coordinate systems, reference lines, and measurement points set before 

import are deleted. Also, measurement points that were tracking points at the time 

of export are imported as fixed points.  

Output the coordinate system, reference segment, and measurement point list to a 

CSV file. In the measurement point list, the values of X, Y, angle, and relative time 

of all measurement points are output as displayed on the measurement point list 

screen. For the tracking point, the measurement result displayed on the 

measurement point list screen is output. 
 

 

The tracking results are output to a CSV file as time series data. 

Refer to "Appendix C Input / Output Data File Format (p.59)" for information on 

import / export and time series data file formats. 
 

 

When the measurement point is selected in the list, it moves to the frame of 

measured relative time. 

 

2.2.2 Auto Tracking 

Detects the position of the specified marker or feature point on the image and performs 

automatic tracking. The main steps of automatic tracking are as follows. 

1) Specify tracking point on image 

2) Adjust tracking parameters. 

3) Execute tracking. 

4) Check tracking results 

 

Also, perform "2.1.4 Image Quality Adjustment (p.11) " as necessary. 
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Below is a description of each step. 

 

1) Specify tracking point on image 

To add a tracking point, select [Tracking point] from [Point type]. 

Click on the screen to add a tracking point. Up to 5 tracking points can be added. 

 

 
 

A template area in purple and a rectangle indicating a search area in light blue are displayed 

around the selected tracking point. 

 

2) Adjust tracking parameters 

Adjust the tracking parameters so that tracking is performed correctly. 

Refer to “Tracking Parameters (p. 30)” for details. 

 

3) Execute tracking 

Automatic tracking is performed only within the playback frame range. 

By changing the playback frame range before tracking execution, it is possible to 

automatically track only any frame range.  

 

Click [Track selected] to track only the tracking point selected in the list.  

Click [Track all] to track all tracking points.  

 

Click [Del selected result] to delete the tracking result of the tracking point selected in the list. 

Click [Del all results] to delete the tracking results of all tracking points. 
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When tracking is executed, the tracking progress screen shown above is displayed. 

Screen operation on MVIEW is not possible during tracking. 

When tracking is complete, the tracking progress screen is closed automatically. 

 

Interruption in progress is interrupted with the [Interruption] button. The analyzed tracking 

results before the interruption remain. 

 

Select [Update image view] to update the image display according to the frame being 

tracked. 

In addition, it takes a long time to complete tracking because of image update processing. 

 To give priority to tracking speed, uncheck this setting. 

 

4) Check tracking results 

 
 

The tracking status of each tracking point can be checked from [Track status] of the 

measurement point list. 

The “Not tracked” tracking point indicates that tracking has never been performed or the 

tracking result has been deleted. 

The “Done” tracking point indicates that tracking has been performed even once and tracking 

has been completed, or tracking has been interrupted but there is a tracking result. 

The tracking point of “Failure” indicates that automatic tracking has failed. 

 

The tracking result of the current frame is displayed in the X, Y coordinate values and angle 

of the tracking point. If there is no tracking result in the current frame, "-" is displayed. 

 

The results of auto tracking can be output to a CSV file from [Save as timeline]. 

The time, and the X coordinate, Y coordinate, and angle of each measurement point are 

output to the CSV file. In the case of fixed point, the same coordinate value and angle are 

output at all time. In the case of a tracking point, coordinate values and angles obtained by 

automatic tracking are output only for tracked frames.  
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□ Retry Tracking 

 

When performing automatic tracking, if there is a tracking point that has already been 

tracked, the confirmation screen is displayed asking whether to retrack each tracked point. 

 

 

 

When [Yes] is selected, only untracked frames are tracked, and tracked frames are not 

overwritten but remain. If [No] is selected, re-tracking will not be performed. The tracked 

frame remains as it is. 

 

 

□ Automatic tracking of image quality adjusted, rotated and inverted 

 

Automatic tracking is performed on an image to which "2.1.4 Image Quality Adjustment 

(p.11)" and "2.1.5 Image Rotation / Reversal (p.15)" have been applied. 

If the result is not correct in tracking, automatic tracking results are expected to be improved 

not only by adjusting the tracking parameters on the next page, but also by adjusting the 

image quality to display clearly the markers and feature points of the tracking target. 

 

 

 

□ Tracking parameter 

 

From the [Tracking params] tab, set the default and tracking parameters for each tracking 

point. There are four tracking parameters: “Template size”, “Update template”, “Search area”, 

and “Under threshold”. 
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• Track point 

 

Select the tracking point for parameter change. 

The parameters set in [Default] are applied to the tracking parameters of the newly added 

tracking point.  

When [Default] is selected and the tracking parameter is changed, the tracking parameter of 

the tracking point to be added next time is also changed. It does not affect the tracking 

parameters of existing tracking points or tracking results.  

If tracking parameters are changed by selecting each tracking point other than [Default], the 

tracking parameters of the selected tracking point will be changed. It does not affect the 

tracking results already tracked. 

 

• Template size 

A template is an original image that is used as a reference for correlation. 
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Sets the size of the template in pixels.  

Find the image with the highest correlation with this template among the images.  

The size of the template affects the tracking speed. 

 

• Update template 

Set whether to update the template frame by frame. 

If the target rotates or deforms, the template needs to be updated, so make the minimum 

necessary update. 

However, as the template is updated, the center point detection accuracy decreases, so it is 

recommended to not update, especially when there is no rotation or deformation.  

 

• Search area 

The search area is the area where high correlations are sought. In the search area, move 

the template image little by little to find a high correlation part. 

The size of the search area is set as a percentage based on the size of the template. 

If the movement speed of the tracking target is high, enlarge the search area. 

If an image similar to the template image of the tracking target exists around the tracking 

target, make the search area smaller to avoid false recognition. 

The size of the search area affects the tracking speed. 

  

• Under threshold 

The under threshold of the correlation coefficient is the value of the degree of correlation 

expressed as a number from 0 to 100. When the under threshold of the correlation 

coefficient is 100, the two images match perfectly, and the smaller the numerical value, the 

lower the degree of correlation. 

When [Confirm stop, when less than threshold.] Is ON and the correlation coefficient falls 

below the threshold during automatic tracking, the dialog is displayed to confirm the 

suspension of tracking. If it is OFF, tracking is continued with low correlation even if the 

correlation coefficient falls below this threshold during automatic tracking. 

 

When [Yes] is selected in the tracking suspension confirmation dialog, automatic tracking is 

suspended. The tracking results before the interruption remain. If [No] is selected, 

automatic tracking will continue.  
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2.3 Image Overlay 

The images displayed on the screen are superimposed and displayed in 2/4 split display.  

 

 
 

 

 

Apply transparency and up / down / left / right inversion to the original image and overlay it on 

the target image. The image quality adjustment and image rotation / reversal applied to the 

original image are also applied to the image superimposed on the target image. 

 

 

 Turn on / off overlay display. 

 

 

 

When the button is clicked, it will become "Determine overlay area 

mapping". Specify a line segment where to overlay on both the 

source screen and the target image. After specifying the line 

segment, click the "Determine overlay area mapping" button to 

display the image in a superimposed state. 
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Specify transparency, up / down, left / right reverse of original 

image. 

At 0 transparency, only the target image is completely transparent to 

the original image. 

With a transparency of 100, only the original image is displayed with 

the original image displayed on the front. 

2 split 

 

4 split  

 

 

Specify the original image and the target image. When dividing into 

four, select from upper left / upper right / lower left / lower right. 

 

Color the area to overlap. 

 

The size, position and rotation of the area can be manually adjusted 

using the displayed markers. 

 

 Clears the settings of the manually adjusted area and makes the 

entire image a superimposed area. 

It can not be used when window maximization is enabled. 
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2.4 Create Report 

The displayed state can be output to still image (BMP / JPG) or Word document. 

 

note  In order to output Word documents, it is necessary to install Microsoft Word 2016. 

 

  

 

 

2.4.1 Output target frame setting 

 

 

It is possible to simultaneously perform the operation of "report creation" and the operation of 

the image. An output frame can be added by clicking the "Add current frame" button while 

In the test information list, select the test 

information to be inserted on the first 

page of the Word document. 

The added frame is listed. The frame is 

added in the order of operation.Ordered 

in addition operation order instead of 

frame order. 

Perform frame addition operation. 

See "How to add a frame" below. 
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displaying an image. 

□ How to add a frame 

• Add current frame 

Pressing "Add current frame" adds one frame displayed. The frame type is relative time. 

• Batch frame export setings 

Specify "Begin" frame, frame "Interval", "Num of output" and press "Add frames". 

Pressing "Set current frame to begin" sets "Begin" to the current frame. 

 

When “Follow play range” is pressed, the playback range on the image side is reflected in 

“Begin” and “Interval”. Changes in the playback range made with the playback slider are 

reflected. Specify "Interval" in "Batch frame export settings". 

2.4.2 Output settings 

Output the frame set in "Output target frame" tab to still image (BMP / JPG) or Word document.

 

  

Export format Select from BMP / JPEG / Word document. 

Color format Select the color of the image after output. 

Grid  Set the grid to be superimposed on the image. 

Word export  It is a specification when outputting to Word document. 

Specify the frame to be output in one page. 

The wrap direction specifies the direction in which the time advances. 
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Image export It is a specification when outputting to BMP / JPEG. 

The original size of the magnification / 50% / 25% is the magnification 

relative to the original size of the image. 

Custom specifies the combined width and height. An area obtained by 

dividing the specified width and height is assigned to one image. 

2.4.3 Create Report 

After a series of frame additions and settings, create a report with the [Create] button. 

 

 

 

 

The progress of the report creation is displayed in the progress bar. 

When report output is complete, the save destination is opened in Explorer. 

 

In the report, an image with image quality adjustment and image rotation / reversal applied 

is output. 

 

 

□ Report output of simple measurement and image superposition 

Simple measurement and image superposition are effective. If the coordinate system, 

measurement points of simple measurement or the superimposed image is displayed on the 

screen, the image as it is displayed on the screen is output as it is to the report image. 

 

note  If report output is performed with the MVIEW application screen size small and 

simple measurement and image overlay enabled, the report image will be output in a 

small size, or the image may not be output because the image size is too small There 

is a case. In this case, maximize the application screen and then execute report 

output again. 
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3. Settings 

Configure MVIEW settings in "Options" of the "Settings" menu.  

3.1 Folder 

 
 

Image Folder   Specify the first folder to open when opening the image. 

 

Measurement Folder  Specify the folder to export the simplified measurement result. 

 

Report Folder   Specify the folder for report output. 

   Save destination can be specified for each report save format. 

 

Snapshot Folder   Specify the save destination folder of snapshot image. 

 It is also possible to specify the image file format at the time of 

saving and whether to include the graph screen in the image. 

 

Save latest opened/saved location. 

If checked, the above settings will be automatically changed when the 

operation is performed. 
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4. Specifications 

4.1 Computer Requirements  

OS Windows 10 Pro (32 / 64bit) 

（※Only the latest update of Windows 10 performs operation check.） 

Memory 4GB or greater 【8GB8GB or greater recommended】 

Display Full color, screen size of 1920×1080 or greater, screen DIP setting of 96dpi 

Disc drive 300MB for program 

Other Microsoft Word 2016（Required for report output function specification） 
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4.2 Supported file format  

The types of files that can be played back with this software are as follows: 

MCFF .mcf MCFF stands for MEMRECAM Camera File 

Format, and is an image file of one 

scene recorded by a MEMRECAM series 

camera. 

AVI (Monochrome) .avi Monochrome 8bit AVI 

AVI .avi Color 24bit AVI 

Windows Media Video .wmv Color 24bit WMV 

TIFF (Monochrome 8bit) .tif Monochrome 8bit TIFF 

TIFF (24bit) .tif Color 24bit TIFF 

BMP (Monochrome 8bit) .bmp Monochrome 8bit ビットマップ 

BMP (24bit) .bmp Color 24bit ビットマップ 

JPEG .jpg Color 24bit JPEG 
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Appendix A 

List of Shortcut Keys 

□ GUI representation 

Result Shortcut Key 

Show / Hide main toolbar F7 

Show / Hide Camera Information Bar F8 

Show / Hide Item Toolbar F9 

Show / hide status bar F10 

Display of property screen Ctrl＋P 

Display option screen Ctrl＋Shift＋O 

 

□ Application control 

Result Shortcut Key 

Close the application Alt＋F4 

Snapshot shooting Ctrl＋S 

Simple measurement Ctrl＋Shift＋M 

Image quality adjustment Ctrl＋Shift＋Q 

Report creation Ctrl＋Shift＋R 

Image superposition Ctrl＋Shift＋S 

Open the manual F1 

 

□ Open and close files 

Result Shortcut Key 

Open file in 1 split view Ctrl＋1 

Open file in 2 split view Ctrl＋2 

Open file in 4 split view Ctrl＋4 

Close file Ctrl＋W 
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□ File playback control 

Result Shortcut Key 

Regeneration / stop Ctrl＋Space 

Loop play / stop Ctrl＋Shift＋Space 

"Stop by 1 frame" while stopped, increase playback rate 

during playback 
Ctrl＋→ 

"Stop 1 frame" while stopped, lower playback rate during 

playback 
Ctrl＋← 

Jump to trigger frame (T0 frame) Ctrl＋T 

Jump to start frame of playback range Ctrl＋Home 

Jump to end frame of playback range Ctrl＋End 

Jump to first frame Ctrl＋Shift＋Home 

Jump to final frame Ctrl＋Shift＋End 

 

□ Image dsplay 

Result Shortcut Key 

Full size view Ctrl＋A 

Zoom tool Ctrl＋Z 

Display entire image Ctrl＋F 

Hand tools Ctrl＋H 
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Appendix B 

 Test information file format 

By creating a test information file and placing it in the test folder, it is possible to display test 

additional information such as test name, date / time, comments, camera information, etc. in 

the MVIEW screen. In addition, for image files that do not have recording speed and recording 

frame range information, recording speed and recording frame range can be assigned for 

playback. 

The test information file is in INI file format. 

Create and edit test information files using an editor that can edit text files. 

If there are multiple test information files in the test folder, the test information file detected by 

the MVIEW application first is applied. 

 

□ File extension of test information file 

The test information file is in INI file format. 

Create a file with the file extension ".ini". 
 

□ File name of test information file 

If the file extension is ".ini", there is no restriction on the test information file name.  
 

□ Test information file format 

 Write in the following format. When the exam folder is opened in MVIEW, the INI file 

described in this format is automatically read. 
 

[TestInformation] 

TestName=Test 

Date=2018/9/1 

TestNo=AA201 

TestType=AA3 

Project=KFP 

Comments=There is no longer… 

Camera_Num=3 

[Cam_0] 

Name=Camera1 

Frames=301 

FrameRate=1000 

T0=100 

[Cam_1] 

Name=Camera2 

Test Info. 

Camera Info. 
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Frames=301 

FrameRate=1000 

T0=100 

[Cam_2] 

Name=Camera3 

Frames=301 

FrameRate=1000 

T0=100 

 

 

Test Information Format 

"Test information" described in the test information file is described using the following sections 

and keys. There is no limit to the parameter value. 

 

Section TestInformation Test Information Section 

Key TestName Display the name of the test. 

Date Display the test date. 

TestNo Display the test number. 

TestType Display the test type. 

Project Display project name. 

Comments Display the comment. 

 

  



MVIEW User’s Manual 

～Appendix B～ 

 

 

(00105)F  55 / 65 

 

 Camera information format 

The "camera information" described in the test information file is described using the following 

sections and keys. 

Only “Name (Camera Name)” has no limit on the parameter value. Parameters other than 

“Name (camera name)” can only be written numerically. 

 

Section TestInformation Test Information Section 

Key Camera_Num Number of cameras 

 

Section 
Cam_** 

e.g.）Cam_0 

Camera information section 

"**" is a number from "0" to "Camera_Num - 1". 

Write a section for each camera, and for each sectionDescribe 

the necessary parameters. 

Key 
Name 

Camera name 

Specify a file name or camera name string. 

Frames 
Number of frames 

Specifies the total number of frames as an integer. 

FrameRate 
Frame Rate [pps] 

Specify the frame rate for recording as an integer. 

T0 

Trigger frame [Frame] 

Specify the frame number from the top as a trigger frame as 

an integer. 

 

The operation changes as follows according to the specification of Name. 

1. When "Name" is the file name 

By specifying the file name excluding the extension in the key "Name (camera name)", the 

frame range and frame rate are assigned to the image file such as WMV file that does not 

have the information of frame range and frame rate. 

 

note  Camera information can not be assigned to sequential image files (BMP, JPEG, TIFF) 

and MCFF files. 
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The following information is assigned to the frame range and frame rate. 

 

Recording range：The frame range obtained from the key "T0" and the total number of 

frames included in the image file  

 

Frame rate：Value of key "FrameRate" 

 

If there are multiple files that match “Name”, the specified frame range and frame rate will be 

assigned to all files. 

The number of frames specified in “Frames” is ignored, and the number of frames the file has 

is applied as it is. 

In the camera information screen, the frame range obtained from the values specified for the 

keys "Frames" and "T0" is displayed as "Recoded range". 

 

 

2. When "Name" is not a file name 

The camera name specified in the key "Name", the frame range obtained from the keys 

"Frames" and "T0", and the recording speed specified in the key "FrameRate" are 

displayed on the camera information screen. 
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Appendix C 

I / O data file format 

□ Waveform data (CSV file format) 

The waveform data file is configured in the following format. 

Files are described by separating them with commas. 

The first column describes the item name and time (or sample number) of time series data. 

The second and subsequent columns describe waveform data information and output data 

values. Describe the data of each channel with one column as one channel. Channel numbers 

start from "0" on MVIEW. 

Write the following information one by one in any of the 1st to 57th lines. Use either English 

or Japanese item names. There is no restriction on the lines and order to be described. 

As MVIEW acquires each data from the item name, if the item name is different, it is not read 

correctly as waveform data. 

In addition, please write "arbitrary character string + comma (,)" in the line which is not 

used. (e.g.: Dummy,) If there are blank lines or lines containing only commas, the data start 

position will be shifted and waveform data can not be displayed correctly.  
 

Item Contents 

TestName 

Test number 

Describes the input device name of waveform data of each channel. 

Only the test number of channel 0 is displayed in the graph 

property. 

ChannelName 

Part name 

Describe the channel name of each channel. 

SamplingRate 

Sampling (Hz) 

Describes sampling frequency at waveform input of each channel. 

A space is inserted immediately before "(Hz)". 

DataCount 

The number of 

data 

Describes the number of sampling data for each channel. 

Unit 

Characteristic 

value name 10 

Describes the unit of each channel. 
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The 58th and subsequent lines are time series data of each channel. 

The first column describes the time or sample number. 

In MVIEW, the time or sample number specified in the first column is ignored, and the time 

determined from the sample number with the 58th row set to 0 and the sampling frequency 

is automatically applied. 

 

The following is an example of a waveform data CSV file. 
 

Line 

number 

File content 

1 TestName,Input device A,Input device A 

2 ChannelName, acceleration, Voltage 

3 SamplingRate,5,5 

4 DataCount,10,10 

5 Unit,m/s^2,V 

6～57 Dummy, 

58 0,0,3 

59 1,1,3 

60 2,3,3 

61 3,9,10 

62 4,1,8 

63 5,-7,6 

64 6,-10,4 

65 7,-9,2 

66 8,-8,0 

67 9,-7,-2 
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□ Simple measurement import / export file (CSV file format) 

The simplified measurement import / export file consists of a header indicating the item 

name of each column, and data of all configured measurement points. 

The header is displayed on the first line of the file, and the data of the measurement points is 

output on the second and subsequent lines, as many as the number of measurement points.  

 

The header format is as follows, with items of measurement point, coordinate system, and 

reference line separated by commas. The header is all printed on the first line of the file. 

 

・Japanese environment 

No.,名称,X[“基準線分単位”],Y[“基準線分単位”],角度[deg],相対時刻[sec],試験名,カラーグループ,原点 X,原点

Y, 

原点角度[deg],基準線分 始点 X,基準線分 始点 Y,基準線分 終点 X,基準線分 終点 Y,基準線分実長,基準線分単位 

・English environment 

No.,Name,X[“Unit”],Y[“Unit”],Angle[deg],RelativeTime[sec],TestName,Color Group, 

Origin X,Origin Y,Origin Angle[deg],StdStart X,StdStart Y,StdEnd X,StdEnd 

Y,StdActualLength,StdUnit 

 

The test name is the "test name" of the test information. It is ignored when importing and 

the test information file name is used as it is. 

Color group is a numerical value that indicates the color of the measurement point. The color 

of each measurement point at import is determined based on this value. 

Coordinate system and reference line information is output in pixel units with the lower left 

corner of the image as the origin. This information is output to all measurement points. At the 

time of import, for each measurement point, the position of the measurement point is 

evaluated from the coordinate system and reference line segment that each measurement 

point has. 

The setting screen of the simplified measurement is set with the values of the coordinate 

system and reference line of the last measurement point. 

 

Regardless of the language setting of your PC, you can import Japanese / English export files.  
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□ Simple measurement time series data (CSV file format) 

Simple measurement time series data consists of a header indicating the item name of each 

column and numerical data of each item.The header of the first line of the file, the time and 

the measurement results of each measurement point are output to the second and 

subsequent lines. 

The output range of time series data is from the first frame to the last frame. 

 

The format of the header is as follows, with the time at the left end followed by the X, Y, and 

angle values of each measurement point separated by commas. Only the number of 

measurement points is output. The name of each measurement point is output to 

"measurement point name". 

 

Time[sec],”Name 1”(X)[“Unit”],” Name 1”(Y)[ Unit”],” Name 1”(Angle)[deg], … , 

” Name N”(Angle)[deg] 

 

The fixed point time series data does not change in position between frames, so the same 

measurement results are output for all frames. 

As the time-series data of the tracking point, measurement results are output only for the 

tracking frame range. Untracked frames will be blank.  
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□ Image quality adjustment setting (INI file format) 

[DIBIC] 
Section name for image 

quality adjustment 
 

RGain=1.000 
Color balance:  

Red gain factor value 
（0.0 ～ 2.0）［initial value:1.0］ 

GGain=1.000 
Color balance:  

Green gain factor value 
（0.0 ～ 2.0）［initial value:1.0］ 

BGain=1.000 
Color balance:  

Blue gain factor value 
（0.0 ～ 2.0）［initial value:1.0］ 

B-YGain=1.000 
Saturation:  

B-Y gain coefficient value 
（0.0 ～ 2.0）［initial value:1.0］ 

R-YGain=1.000 
Saturation:  

R-Y gain coefficient value 
（0.0 ～ 2.0）［initial value:1.0］ 

Hue=0.000 Hue rotation value （-45.0 ～ 45.0）［initial value:0.0］ 

Brightness=0 Brightness value （-127 ～ 127）［initial value:0］ 

Contrast=1.000 Contrast value （0.0 ～ 2.0）［initial value:1.0］ 

GamMin=0 Minimum value of gamma （0 ～ 254）［initial value:0］ 

GamMax=255 Maximum value of gamma （1 ～ 255）［initial value:255］ 

GamCoef=1.000 Gamma correlation value （0.01 ～ 2.10）［initial value:1.0］ 

EnhSel=0 Enhanced value 
（0 ～ 3）［initial value:0］ 

※ 0:OFF, 1:LOW, 2:NORMAL, 3:HIGH 
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■ USA Contact

NIT Americas Incorporated (nac Image Technology USA) 

Address 543 Country Club Drive, Suite B-534 Simi 

Valley, CA 93065 USA  

TEL +1 805-584-8862 

FAX +1 805-584-3642 

E-mail sales@nacinc.com 

Website http://www.nacinc.com/ 

■ European Contact

MESSRING GmbH

Address Friedrichshafener Straße 4c

82205 Gilching, Germany

TEL +49 8153 407-96-333 

FAX 

E-mail sales@messring.de

Website http://www.messring.de 

■ Japan/Asia Contact

nac Image Technology Inc. 

Address 2-11-3 Kita-Aoyama, Minato-ku Tokyo 107-

0061 Japan  

TEL +81 3-3796-7903 

FAX +81 3-3796-7908 

E-mail: nacinternational@camnac.co.jp 

Website: https://www.nacinc.jp/ 

March 2019 
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